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A B S T R A C T

Radio-telemetry studies allow the accurate measurement of the survivorship of

many vertebrates, without many of the mathematical problems associated with

capture-recapture analysis using markers such as bands, tags or toe-clips. The

assumptions involved in the analysis of radio-telemetry data are described and

rules are given for the consistent handling and analysis of data. Some examples

of different survivorship estimates are given from ongoing studies of the threats

to brown kiwi (Apteryx mantelli) in Northland, New Zealand, and from a

published study of the survival of kereru (Hemiphaga novaeseelandiae). From

the kiwi study, we give a sample Excel spreadsheet for the storage of raw data

and for processing and transferring them to the SPSS statistical package to carry

out survival analysis. We provide worked examples in Excel for the calculation

of survivorship rate using simple methods. We also give a worked example in

both Excel and SPSS for the Kaplan-Meier procedure and for testing differences

in survival between two or more groups of individuals using a log-rank (Mantel-

Haenszel) test. Under certain circumstances, these methods can be used to

estimate survivorship, and compare survival in two or more groups of animals

(or plants) marked in other ways.

Keywords: Excel, Kaplan-Meier, log-rank (Mantel-Haenszel) test, Mayfield

method, product-moment, survival analysis



6 Robertson & Westbrooke—Survivorship and radio-tracking studies

1. Introduction

Conservation managers often aim to maintain or enhance populations of

threatened species and / or reduce populations of pest species. In any animal

population, fluctuations in the number of individuals result from changes in

four different components of life history: birth rate, death rate, immigration and

emigration. It is useful for conservation managers to be able to measure or

estimate these four variables for threatened species and pest species alike. For

example, in New Zealand managers aim to increase birth rate and / or decrease

death rate of kiwi by increasing the death rate (through trapping or poisoning)

of pest species such as possums, stoats and ferrets.

This paper was written in response to requests for advice from conservation

managers in the Northland and West Coast Conservancies of the Department of

Conservation (DOC) who are collecting survivorship data on kiwi through

radio-tracking studies. We assume a basic knowledge of mathematics, and do

not go into the mathematical theory behind the tests used, but we provide some

key references that give that background for those who are interested. We also

assume an ability to use Excel spreadsheets, but a copy of an Excel workbook at

hand with real or dummy data will enhance the understanding of this paper.

The aim has been to provide a practical guide to help field workers and

researchers to record and analyse data used to calculate the death rate and

hence longevity of animals from radio-telemetry data. Some of the mathematics

used here can be more generally applied to data from studies of animals (or

plants) marked in different ways, where individuals are checked very regularly.

2. Background

2 . 1 S U R V I V A L  R A T E S

The term ‘survival rate’ is usually used as a more positive expression than death

rate or mortality rate. Survival rate, s, is the complement of the death or

mortality rate, m, i.e. s = 1 – m. For example, if 70% of kiwi survive from one

year to the next (s = 0.7), then 30% have died (m = 0.3). The probability that an

animal survives may vary with individual characteristics such as age, sex, size

and colour, or as a function of external variables such as management regime,

habitat type, exposure to predation, population density, weather or season. It is

often useful for conservation managers to compare survival rates between two

or more different groups of individuals. For example, comparisons can be made

between survival in treatment and non-treatment areas, or between males and

females (a population may be in grave danger even though the overall survival

rate appears reasonable, if there is a very low number of individuals of one

gender).
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2 . 2 M E T H O D S  A V A I L A B L E  F O R  C A L C U L A T I N G

S U R V I V A L

There is a large body of scientific literature describing methods for estimating

the survivorship of animals (and plants), much of it derived from medical and

engineering studies. The simplest method (survivorship = number of survivors/

number at start) is used when the entire initial population is marked (or

otherwise known); immigration and emigration are impossible (e.g. some birds

on islands, plants in a quadrat); all surviving animals or plants can be relocated

with confidence at fixed intervals thereafter; and all individuals have an equal

chance of surviving from one time interval to the next. Because real life is not

usually that simple, and all four conditions are seldom met simultaneously, a

number of complex mathematical methods have been developed for the

analysis of capture-recapture / resighting data when only part of the population

is marked, immigration and emigration are possible, when sampling intervals

are irregular and when chances of resighting or survival vary between

individuals (for reviews and an introduction to the literature, see Clobert &

Lebreton 1991; Lebreton et al. 1992). All methods include one or more

assumptions, such as that the animals are equally likely to be captured and then

recaptured / resighted; marked animals are not affected by being marked; or,

for some methods, the population is closed (no immigration or emigration).

The relatively recent development of radio-telemetry to mark animals removes

the need for some of these assumptions or allows assumptions to be better

examined. As a method for the field, we believe that radio-telemetry provides

the best available tool to achieve the ideal situation of being able to follow

individual wild animals from birth through to death, enabling researchers to

record the outcome of each of the animal’s breeding attempts, and to record

movements and social behaviour during its lifespan. The intensive study of a

relatively small sample of individuals can provide answers to a number of

conservation management questions more readily than alternative approaches,

such as a broader mark-recapture study.

2 . 3 R A D I O - T E L E M E T R Y

Radio-telemetry is an unrivalled technique for determining the movements,

home-range and habitat use of animals in the wild. It is also proving to be an

exceptionally useful technique for studying the survival of wild animals. A

miniature radio-transmitter is attached to a study animal by a harness, glue or

sutures. By using an aerial and receiver tuned to the correct frequencies,

researchers can track the animal manually, by automated tracking stations or by

satellite, and its location and / or behaviour can be noted. Mortality transmitters

emit a different signal (e.g. increased pulse rate) if the transmitter becomes

stationary for more than a specified length of time, thus indicating that the

animal has died or the transmitter has fallen off; these can be programmed to

change the signal characteristics in an ordered way after changing to mortality

mode, so that the time of day and date of death or transmitter loss can be

recorded.
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There are four main drawbacks to using radio-transmitters in studies of wild

animals. Firstly, the animal has to be recaptured periodically to replace the

transmitter because battery life is limited and transmitters have to be

sufficiently small (usually nominally taken as < 5% of body weight) not to

unduly interfere with the mobility of the animal. Secondly, despite

improvements in transmitter components and batteries in the last decade, some

transmitters fail well before their due date. Thirdly, only a relatively small

number of individuals (< 100) can usually be tracked in an area at one time by

an observer, often because there are only a limited number of frequencies

available. In the past, confusion has arisen when more than one research team

has been using transmitters on different study animals that overlap in

distribution. Finally, the costs of radio-telemetry can be high: standard

transmitters retail at $220–$400 each, satellite transmitters at about $5000

each, and receivers, aerials and replacement batteries are significant additional

costs.

2 . 4 A S S U M P T I O N S  I N  S U R V I V O R S H I P  A N A L Y S I S
O F  R A D I O - T E L E M E T R Y  D A T A

The most important assumption in radio-tracking studies is that the transmitters

do not interfere with the behaviour or survival of marked animals or, for

purposes of comparing two or more subsets of the study animals, if they do

cause some effect, then it is evenly or randomly spread through the entire radio-

tagged population. Another important assumption is that when a record is

entered as censored (i.e. the tracking record is completed but recorded only as

surviving to this time) the censorship should not be linked to a higher chance of

death. This assumption is clearly violated when loss of transmitter contact

occurs in conjunction with death, for example, when an animal drowns in a

river and is washed away, or during human predation, as reported for radio-

tagged kereru (Hemiphaga novaeseelandiae) at Wenderholm (Clout et al.

1995). Equally important is the assumption that a random sample has been

obtained, so that the radio-tagged sample is representative of the whole

population (e.g. kiwi chick samples should be stratified according to time of

year and geographical location because of the marked seasonal changes in the

abundance of stoats, their main predator, and because of edge effects). Another

assumption is that each animal’s fate is independent of the fate of others

(although this may not be the case if animals are killed during catastrophic

events, e.g. bad weather, fire or predator irruption, or if animals are associated

with each other, e.g. by coming from the same nest or pair). In some cases, we

make the additional assumption that the probability of survival remains

constant through time, at least within each subpopulation being studied.



9DOC Technical Series 31

3. Rules for the handling of
survivorship data

As soon as a radio-tagged animal is released, data can start to accumulate.

However, for species that suffer post-handling shock, deaths shortly after

release are often excluded (e.g. Clout et al. (1995) excluded kereru that died

within 1 week of capture). In this case, data collection from survivors should

also start only after this window has passed.

Survivorship data must be handled carefully and consistently to ensure that

estimates made for the population are valid. For example, estimates can be

systematically in error if censoring (the cessation of a tracking record with no

evidence that the individual has died) is not correctly and accurately recorded.

When a field search is made for the animal there are five possible outcomes:

confirmation that the animal is alive; the animal is dead and the transmitter is

recovered; the animal is not found because either it has emigrated or the

transmitter has failed; a shed transmitter is found working but there is no sign of

the animal; or the animal is not actually seen (e.g. because it is in a deep

burrow) but the site of the transmitter is identified. These are outlined below.

Confirmed alive

The date on which an animal is recorded alive, with a functioning transmitter,

becomes the ‘last date’ that the animal was known to be alive. If the transmitter

is removed from the animal at this point, the data from that animal are referred

to as being ‘right censored’, i.e. the tracking record is complete even though

the animal survived beyond this date. No further information can be added to

the survivorship record after transmitter removal even if the animal is resighted

alive some time later, because only live animals are available to be resighted.

Confirmed dead

One major advantage of radio-telemetry over other methods of marking is that it

often enables researchers to find an animal’s carcass, and so determine the

cause of death either from examination of the body (necropsy) or from signs at

the site where the animal has died (e.g. a branch had fallen on the animal). For

survivorship analysis, we recommend that, wherever possible, the date of death

is estimated from the time a mortality transmitter changed its signal, the state of

decay of the carcass, or the amount of growth between last capture and the

time of death (e.g. the bills of kiwi chicks grow at a nearly linear rate in the first

6 months (R. Colbourne and H. Robertson, unpubl. data), so the time of death

can be estimated from bill length).

Where the date of death is not known, use the midpoint between when the

animal was last known to be alive and the date on which the animal was found

dead if visits are 15 or fewer days apart; where the interval exceeds 15 days, use

the date after 40% of the interval between visits has elapsed (Miller & Johnson

1978). It is important to state clearly the method used for these calculations in

reports or scientific papers.
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The animal is not found because it has either emigrated or
the transmitter has failed

Similar rules apply to those used when the animal has died (see above): censor

records at an intermediate date between when the animal was last known to be

alive and the first time the animal was searched for and not found, using the

methods proposed by Miller & Johnson (1978). It is important to record dates

on which an animal was searched for and not found, because that information

will be used in subsequent calculations of censoring date if the animal is not

later found with a functioning transmitter. If the animal reappears bearing a

non-functioning transmitter, then the above dates must be used rather than the

time it reappeared to avoid increasing the apparent survival rate, since only live

animals can reappear. If the animal reappears bearing a functioning transmitter,

then the record reverts to being a continuous record from first capture to the

date of reappearance. But, in the unlikely event that the animal is later found

dead with a non-functioning transmitter, assume that it was alive at the time it

disappeared from the tracking record unless it is obvious that death and

transmitter failure were simultaneous (e.g. when an animal has been killed by a

poacher who has destroyed the transmitter).

The shed transmitter is found working but there is no sign
of the animal

Similar rules apply to those used when the animal has disappeared, with the

tracking record being censored at an intermediate time between when the

animal was certainly alive and when the transmitter was found. If the animal is

later found alive, the original endpoint must stand because of the danger of

introducing a bias toward increased survivorship.

The animal is not actually seen (e.g. is in a deep burrow)
but the site of the transmitter is clearly identified

If the study animal is of a species or age class that is regularly cryptic (e.g. adult

kiwi, which often use very deep burrows), then assume that the animal is alive.

However, if subsequent searches always lead to the same site, censor the record

at an intermediate point before the first record for that site. Whether the animal

has died or shed its transmitter in an inaccessible site can be difficult to

determine and other cues, such as a resighting (or no resighting), a rotting smell

or blowflies associated with the site, or its partner being found with a new

mate, must be used.

If the study animal is found in a highly unusual site (e.g. a kiwi chick in a non-

natal burrow), then assume that the individual died at an intermediate stage

before the first encounter at this site (although note that a dead kiwi chick was

once dragged from one stoat den to another between checks; Pat Miller, pers.

comm.).
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4. Management of data

One of the authors (H.A.R.) developed an Excel spreadsheet for handling

survivorship data from a large-scale (c. 100 birds marked at any point in time)

radio-telemetry study of the threats to wild brown kiwi (Apteryx mantelli) in

central Northland, New Zealand (see Robertson et al. (1999) for more

information on the study). The spreadsheet used for storing survivorship

information about adult brown kiwi from 2 January 1994 to 30 September 1998

is given in Appendix 1 (N.B. data on other age classes of brown kiwi were kept

separate because different assumptions apply to them). The following columns

are used:

‘Band’ and ‘Combination’ identify particular individuals. It is not necessary to

include both variables, but they do provide useful checks if there is an

identification error in the field or a transcription error from field notebooks

to the computer.

‘Sex’ identifies the sex of the bird.

‘Area’ identifies the study area in which the bird was located.

‘Tx’ refers to the most recent transmitter frequency used for the animal. This is

also a useful check on the identity of the bird, as band numbers are often

obscured by reflective tape.

‘On’ stores the date on which the continuous record of radio-tracking of each

bird started. Dates are best shown with one or two digits for days, three

characters for the month, and a two-digit year to avoid ambiguities, e.g. 4-

Mar-97 rather than the ambiguous 4/3/97 which could be 4 March or 3 April

1997, depending on the calendar system used. This can be set up in Excel by

highlighting the column, using Format > Cells > Custom, and then

choosing d-mmm-yy from the options.

‘Off_last’ is the date the transmitter was removed from a kiwi; the estimated or

calculated time of death; the date the record was censored (when a

transmitter fell off, failed or the bird disappeared); or the most recent date

the functional transmitter was known to be on the bird.

‘Total’ is the total tracking period. This is found by subtracting the ‘On’ date

from the ‘Off_last’ date. Excel will want to format this as a date (e.g. 23-Nov-

1900). To format cells in this column as numbers, use Format > Cells >

Number, and choose Number from the category list. To be tidy, set the

number of decimal places to 0. For example, in the first row, the female kiwi

with band number 1079 with blue reflector and Tx 37 was caught and radio-

tagged at Purua on 29 June 1994 and the transmitter was removed on 10

March 1995 after 254 days.

‘Death’ is an indicator of whether the record ended with a death (recorded as 1)

or not (recorded as 0), the latter corresponding to a censored observation.

This should remain at 0 even if an animal is subsequently found dead without

a functioning transmitter, as only deaths during the tracking period can be

used in estimates of survivorship.
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One useful convention is that all ongoing records are shown in bold, all records

ending with the animal definitely dying are in italics, and all records that ended

with the transmitter being removed, falling off or failing (the last is assumed

after only a reasonable time, in case the animal reappears with a functional

transmitter) are in normal font. Using different typescripts does not affect the

numerical calculations and it makes it easier to locate particular individuals or

groups in the spreadsheet, especially when updating the files. Alternatively, a

separate column can be added to note the status of each tracking record (alive,

dead, missing…).

5. Calculation of annual
survivorship and life expectancy

5 . 1 T I M E  S C A L E S

For long-lived animals, such as brown kiwi, it is usual to calculate and report

annual survival estimates. However, for short-lived animals, such as kiwi chicks,

or for short-term radio-tracking studies, it is better to calculate daily, weekly or

monthly survival rates. These can be calculated by raising the survival rate (not

the mortality rate!) to the appropriate power, e.g. a monthly survival of 0.90

equates to an annual survival of 0.90¹² = 0.28, assuming constant survival

throughout the year. Be aware of the effect of raising a rounded number by a

large power, as the final result may be quite different from the true result. In the

example above, if the true monthly survival rate had been 0.9048, then the

annual survival would have been 0.3010. The effect is greatly magnified when

converting daily survival rates to annual rates.

5 . 2 T H E  M A Y F I E L D  M E T H O D

The Mayfield method for analysing nesting success of birds (Mayfield 1961,

1975) is often extended to the analysis of radio-telemetry data (e.g. Trent &

Rongstad 1974; Heisey & Fuller 1985). It provides a simple approximation of

mortality by dividing the number of deaths, d, by the total time, T, that animals

have carried active radio-transmitters. This approach is based on two

assumptions: that the mortality rate is constant and the sample is random. For

example, Clout et al. (1995) recorded ten deaths (d) of radio-tagged kereru at

Pelorus Bridge in 19 321 bird-days (T = 52.9 years), which gave a crude

mortality rate, m, of 10/52.9 = 0.189 per bird per year; an annual survival, s

(= 1 – m), of 0.811 or 81.1% per year; and a life expectancy, L (= 1/m), of 5.29

years.
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From the data in Appendix 1, there were 13 adult brown kiwi deaths in 258.87

bird-years of radio-tracking in central Northland to September 1998, so

mortality is 13/258.87 = 0.0502, annual survival is 0.9498 and life expectancy is

therefore 19.91 years. It is possible to calculate confidence intervals for these

estimates. A confidence interval for mortality rate is:

where 1 – α is the confidence level (for example α = 0.05 for a 95% confidence

interval) and the appropriate values for the χ2 distribution with 2d degrees of

freedom are derived from a statistical table or computer function (Lawless

1982). A confidence interval for life expectancy is given by the reciprocals of

the limits calculated for mortality. For the adult brown kiwi example above, the

required χ2 values (with 26 degrees of freedom) are 13.8 and 41.9, calculated

from the Excel formulae =CHIINV(0.025,26) and =CHIINV(0.975,26). Thus

the 95% confidence interval of the mortality rate is 0.0502/26 × 13.8 = 0.027 to

0.0502/26 × 41.9 = 0.081, and the associated 95% confidence interval for life

expectancy becomes 12.4 to 37.4 years.

This method assumes that survivorship is constant. Where this assumption is

not violated it provides reasonable estimates of survivorship, especially where

sample sizes are large, i.e. the product of the number of tracking years and the

number of deaths recorded is > 500 (e.g. ten deaths in 50 years of accumulated

radio-tracking data), and can be computed and updated very simply at the foot

of the spreadsheet used for storing the survivorship data (see Appendix 1).

5 . 3 K A P L A N - M E I E R  P R O C E D U R E

Constant survival is a strong assumption to make. Unless there are very good

reasons to make this assumption, a more general and mathematically correct

method for the detailed analysis of survivorship data from radio-telemetry

studies is the Kaplan-Meier (KM) procedure, which produces a nonparametric

estimator also known as the ‘product limit estimator’ (for more detailed

discussion of the method see Pollock et al. 1989a,b; Bunck et al. 1995; Klein &

Moeschberger 1997). The KM approach is available in many statistical packages,

and is straightforward to run in SPSS, where it is available as an add-in:

‘Advanced Models’. For those people who do not have access to commercial

statistical packages, we show how, with some manipulations, simple KM curves

can be created in Excel. The KM method has the significant advantage that it

does not include the assumption that survival rates are constant.

Next we provide a worked example of the KM approach in action in SPSS. The

data in Appendix 2 give survivorship information about brown kiwi chicks

living in forest patches in Northland under different management regimes: in

some bush patches the anticoagulant poison brodifacoum was used for possum
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control (and probably caused incidental control of rodents and mammalian

predators), and in others no management was carried out (Robertson et al.

1999). The data reported here differ slightly from those reported by Robertson

et al. (1999) because we have censored observations at an intermediate point

according to the rules given above, rather than the more conservative approach

they used of censoring data at the last date the animal was known to be alive.

The data columns are similar to those in Appendix 1, but ‘Treatmen’ has been

added to enable comparison of the survival of chicks under different

management regimes. Data columns start at the top left hand corner of the

worksheet, and have simple unique names of up to eight characters in the

top row. It is easiest if there are no blank rows, and no extraneous data or

derived sums or rates in the worksheet.

5.3.1 Kaplan-Meier procedure using SPSS

The first step is to create a copy of the data in SPSS. This is most easily done by

importing the Excel worksheet into SPSS. Note that the essential variables for

any KM analysis are one for the survival time and another for whether the

record ended with a particular event (a death in this example). Additional

variables can be used to indicate groups being compared.

Open SPSS then Open > Data >
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Select Files of type Excel (*.xls), then find and click on the file to be opened

following normal Windows procedures.

Clicking on the Open button should lead to the next box:

Select the appropriate worksheet. SPSS takes a guess at the range (shown as

[A1:K162] in the upper box). This may need to be adjusted by typing the actual

range desired in the lower box. When the range is correct, click on OK.

SPSS may give ‘********’ in columns for dates (i.e. On and Off_last), which can

usually be fixed by widening the column to fit the date in.

(Note that although SPSS looks a bit like a spreadsheet, it is very different from

Excel. The two tabs are for two different views of the data: the Data View,

showing all the values, and the Variable View, showing the characteristics

associated with each column of data, which SPSS sees as a statistical variable.

The data may need to be tidied up in Excel or in SPSS to make it into tidy

columns of variables.)
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To create Kaplan-Meier survival curves, select Analyze > Survival > Kaplan-

Meier.

Then select the time variable (in our example Cdays) and use the arrow button

to put this in the Time box and the event indicator (in our example death) into

the Status box.

With the death box selected, SPSS must be told what the values of death mean.

In the example, 1 signifies a death and anything else is censored.
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Click on the Define event button, enter 1, and click on Continue, which

returns the programme to the Kaplan-Meier box.

Click on the Options button on the Kaplan-Meier box, and select Plots >

Survival (and possibly Plots > Log Survival) to get a graph. Now click on OK

and SPSS will spend a while processing, and produce some numerical output in

a separate Output window, ending with a survival curve. Note that the y-axis

title should be edited to read ‘Cumulative survival’, instead of ‘Cum survival’.

Note for this example that the curve shows an initial, very sharp drop in

survival, and then the slope appears to lessen with time.

However, this survival analysis is not very interesting, as it mixes together the

‘Poison’ and ‘Non-treatment’ groups. SPSS will separate these out, using the

variable Treatmen as a factor, but it needs to be recoded as a number first. (This

is just an old-fashioned feature of SPSS.) To recode, return to the SPSS Data

Editor (the output is a separate SPSS Output Window).
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In the Data Editor, go to Transform > Automatic Recode:

Then select the variable Treatmen, and type a new variable name into the box

toward the bottom right.

Click on New Name and then OK. This adds a new variable treat to the data

with numbers instead of words for the two treatments. Now add the new

variable as a Factor.
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Clicking on OK should lead to another lot of output:

Survival Analysis for CDAYS 
 
 Factor TREAT = Non-treatment 
 
  Time      Status         Cumulative    Standard    Cumulative     Number 
                            Survival      Error        Events      Remaining 
 
       3              1       .9444         .0540             1           17 
       4              1       .8889         .0741             2           16 
       8              1                                       3           15 
       8              1       .7778         .0980             4           14 
      10              1       .7222         .1056             5           13 
      10              0                                       5           12 
      14              1       .6620         .1126             6           11 
      15              1       .6019         .1174             7           10 
      16              1       .5417         .1201             8            9 
      21              1       .4815         .1209             9            8 
      31              1       .4213         .1198            10            7 
      34              1       .3611         .1168            11            6 
      37              1       .3009         .1118            12            5 
      38              0                                      12            4 
      39              1       .2257         .1062            13            3 
      52              1       .1505         .0937            14            2 
      65              0                                      14            1 
     172              0                                      14            0 
 
 
 Number of Cases:  18        Censored:   4      ( 22.22%)   Events: 14 
 
 
 
          Survival Time    Standard Error   95% Confidence Interval 
 
 Mean:           45                  14     (       17,        72 ) 
 (Limited to      172 ) 
 Median:         21                  11     (        0,        42 ) 
_ 
 
 
 Survival Analysis for CDAYS 
 
 Factor TREAT = Poison 
 
  Time      Status         Cumulative    Standard    Cumulative     Number 
                            Survival      Error        Events      Remaining 
 
       4              1       .9744         .0253             1           38 
      12              1       .9487         .0353             2           37 
      14              1       .9231         .0427             3           36 
      15              1       .8974         .0486             4           35 
      16              1       .8718         .0535             5           34 
      16              0                                       5           33 
      17              1       .8454         .0581             6           32 
      17              0                                       6           31 
      18              1                                       7           30 
      18              1       .7908         .0659             8           29 
      21              0                                       8           28 
      21              0                                       8           27 
      22              1       .7615         .0697             9           26 
      22              0                                       9           25 
      23              1       .7311         .0732            10           24 
      26              0                                      10           23 
      31              1       .6993         .0766            11           22 
      32              0                                      11           21 
      34              0                                      11           20 
      35              1       .6643         .0804            12           19 
      47              0                                      12           18 
      51              1       .6274         .0840            13           17 
      53              1       .5905         .0868            14           16 
      68              0                                      14           15 
      70              0                                      14           14 
      72              0                                      14           13 
      73              0                                      14           12 
      76              0                                      14           11 
      80              1       .5368         .0940            15           10 
      96              0                                      15            9 
     106              1       .4772         .1007            16            8 
     112              1       .4175         .1043            17            7 
    
      

Continued on next page
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This output has separate tables for the two treatment levels, and produces a

graph with separate lines for them.

The curves look different. Note that each curve changes only when deaths

occur, and that censored observations are individually marked. Again, the graph

needs the y-axis label edited, and one of the lines needs to be changed to

dashes, so that the lines are readily distinguished without colour (enabling

black-and-white printing). This is achieved by double-clicking on the graph to

open an editing window, carefully selecting just one of the lines, and changing

the Style in the Lines tab of the Properties dialogue box.

     119              1       .3579         .1051            18            6 
     128              1       .2982         .1031            19            5 
     161              0                                      19            4 
     175              1       .2237         .1008            20            3 
     180              0                                      20            2 
     180              0                                      20            1 
     180              0                                      20            0 
 
 
 Number of Cases:  39        Censored:   19     ( 48.72%)   Events: 20 
_ 
 
 
          Survival Time    Standard Error   95% Confidence Interval 
 
 Mean:           96                  12     (       72,       120 ) 
 (Limited to      180 ) 
 Median:        106                  34     (       39,       173 ) 
 
 
 Survival Analysis for CDAYS 
 
                                  Total     Number      Number       Percent 
                                            Events     Censored     Censored 
 
  TREAT        Non-treatment         18         14           4         22.22 
  TREAT        Poison                39         20          19         48.72 
 
Overall                              57         34          23         40.35 
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5.3.2 Kaplan-Meier procedure using Excel

We now present Excel 2002 spreadsheets (Appendices 3 and 4) to handle the

analysis of radio-telemetry data, designed for those who do not have access to

standard statistical packages. While we have attempted to get things right, we

cannot guarantee that these sheets will necessarily handle all datasets, nor that

they will work in later versions of Excel. The actual spreadsheets used here are

available by request from the senior author. Please acknowledge this paper if

these Excel spreadsheets are used.

In this section, we will derive the Kaplan-Meier survival rates using the same

example used for SPSS.

The key information for each individual is the same as for SPSS: the date of each

event and whether there was a death or censorship. There may also be a

covariate—in our example, Poison versus Non-treatment. In Excel, the process

works best if there are no empty rows or columns in the main data area, and if

any other information, such as derived totals, is separated from the actual data

to be analysed for each individual by an empty row or column.

The first step is to select a cell in the main data area and create a pivot table:

click on Data > PivotTable and PivotChart Report. (Note that the following

instructions are for Excel 2002. Details may differ in different versions of Excel,

but it will generally be possible to create the same table, providing the Pivot

Table tool is available.)

Go through the three steps of the wizard, checking at step 2 that exactly the

rows and all the columns needed have been selected; extra columns do not

matter. All the columns need meaningful headings. At step 3, the default is to

put the pivot table on a new worksheet. It is generally a good idea to leave the

data uncluttered on its own sheet. The skeleton of the pivot table will now be

on the new sheet.
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Now drag the time variable (Cdays in our example) to the left of the table where

it says ‘drop row fields here’. Drag the covariate factor if there is one (Treatmen

in our example), then the event indicator (censorship or death; ‘Death?’ here) to

the top of the table to be the column fields, and ignore the page fields area. Also

drop any variable with a complete set of values (i.e. having no empty cells) in the

middle of the table. Preferably use one with character values, as this will default

to giving the count of items that are required. Excel will automatically choose to

sum a numeric variable, which will then have to be changed to a count. (In our

case we used Treatmen.) It is important that the covariate (Treatmen) is to the

left of the event indicator (Death?), which can be achieved by dragging the labels

to put them in the correct order. This should produce the following table:
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The Field List can now be closed, and the pivot table values can be used to

derive the Kaplan-Meier survival rates.

We now describe in detail the formulae for creating the KM rates. With access

to our spreadsheet, they can be copied over to apply to other data. However, it

will be necessary to carefully check that the formulae refer to the correct cells.

Our workings are shown in Appendix 3, Table A3.1. Note that in the formulae

that follow, a cell reference (e.g. A7) generally must be typed in for cells

in the pivot table, rather than selecting the cell to go into a formula, as

Excel can create complicated references when a cell in a pivot table is

selected.

The first group: ‘Non-treatment’

Column I: Day In the first column next to the table, create a copy of the time

variable. In our example, we put =A6 in the cell I6, and copied it

down the side of the table as far as, but not including, the Grand

Total row. Next type 0 in the cell just above the first event day: in

our example, I5. (This column will make things easier when we

want to create a graph, as it is hard to select exactly the cells

required from the pivot table itself.) Add a label, e.g. Day,

immediately above this column, in cell I4. Type labels at the head of

each column as shown in the table.

Column J: At risk. Put the total number at risk (i.e. the sample size of the Non-

treatment group) in the cell next to the first day of a record, in our

case enter =D47 in J6. In the next cell down we take the value of

the cell above, minus the value of total events, both censorships

and deaths (i.e. 0s and 1s), from the preceding line. In our

example, we put =J6-D6 in J7 and then copied this down. This

gives the number at risk before any events on each day.

Columns K and L: Empirical death and survival rates. The empirical

death rate is simply the number of deaths divided by the number at

risk. Thus, we divide the appropriate cell in column C by the cell in

the same row in column J. For example, we typed =C6/J6 in K6,

and then copied this down into all the appropriate cells. The

empirical survival rate, which is essential, is 1 minus the death rate,

so put =1-K6 in L6, and copy that down.

Column M: Kaplan-Meier (KM) product moment survival rate. This is the

information that we really want. Create it by taking the cumulative

product of the survival rates to date. Type ‘1’ in the row

corresponding to time 0 (in M5 in the example), to represent 100%

survival rate initially. In M6, put =M5*L6, and copy it down.
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The next group: ‘Poison’

Now we have the key item we want for the first group. After putting useful

headings on each column, as in our example, copy columns J to M into the next

columns (N to Q) so the formulae can be slightly adjusted to give the KM

survival rates for the second group (the references need to be corrected). The

first cell in the new At risk column (N6) now must refer to the total in the

second group (=G47 in our example). Adjust the next cell (N7) to refer to the

cell immediately above, less the total number of losses (censorships and deaths)

in this group (=N6-G6 here) and copy this down. The next column, empirical

death rate, must be adjusted to ensure that it refers to the number of deaths in

this group, divided by the number at risk. (Thus O6 has =F6/N6 in our

example.)

There may be some entries ‘#DIV/0!’ at the bottom of the table, if there are no

longer any at risk in this group. In the example, this happens for the last couple

of dates for the first group. It will pay to clear these problem cells (only) before

graphing, as Excel will tend to interpret these as zero values. However, note

that these formulae were required for the second group, and were used for

copying.

Further useful calculations for standard errors and confidence intervals can

follow, but first it is worth graphing these results. To graph the KM survival

rates against time, put a short heading at the top of each group of KM rates.

Select the time (column I), including the heading, and similarly the columns of

KM survival rates. Now click on Insert > Chart, and select XY (Scatter). This

will give a graph of the survival curve like the one below:

This graph has been tidied up by adding labels; adjusting the vertical scale, the

position of the legend and the size of each point; changing the symbols; and

deleting the background and gridlines. It represents the survival rates

adequately, but includes points at days where there are censorship events as

well as points at each death. The SPSS graph shows the difference between the

two types of events. Excel can also graphically show the differences between

the types of events, if extra columns and the IF function are used, but we have

not added this refinement.
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The median duration of survival can be readily calculated by finding the time at

which survival first drops below 0.5. Reading the values for the KM survival rate

in the example, this is reached at 106 days for the Poison group, but at 21 days

for the Non-treatment group.

The next step is to use Greenwood’s formula (Klein & Moeschberger 1997: 84)

to calculate the standard error and confidence intervals for the KM survival rate

for each group. To do this for group 1, insert five columns after the KM rate for

the first group. This and the following steps are shown in Appendix 3, Table

A3.2 (Table A3.1 shows only the workings to this point).

Columns N and O: Two steps to Greenwood’s formula. The first step (to

generate the values for column N) involves the following

calculation for each group: divide the number of deaths by the

product of the number at risk and the number at risk less the

number of deaths. In the example, we put =C6/(J6*(J6-C6)) in N6,

and copied it down through both groups. The second step involves

calculating the cumulative sum, by putting =SUM(N$6:N6) in O6,

and copying it down. Note that the $ sign fixes a cell reference so

that it does not change during copying.

Column P: Standard error. This is simply the product of the KM survival rate

and the square root of column O. Put =M6*SQRT(O6) in P6, and

copy it down through both groups. This gives a measure of the

error in the KM rate. However, confidence intervals are often more

useful.

Columns Q and R: 95% confidence intervals. Because survival rates should

be between 0 and 1, it is best to use a different approach to the

usual ± 1.96 × standard error (Klein & Moeschberger 1997: 97).

Instead the formula for Q6 is =M6^EXP(-1.96*SQRT(O6)/LN(M6))

and for R6 is =M6^EXP(1.96*SQRT(O6)/LN(M6)). Note that the

only difference is the change of signs (– then +) after EXP( .

These columns can then be copied after the next group, and almost all the

formulae will translate as needed. The only adjustment that should be required

is a change in the first step of Greenwood’s formula to ensure that it refers

twice to the number of deaths in the correct group. In our example, the formula

in W6 should be =F6/(S6*(S6-F6)), and this should be copied down.

That is all for the Kaplan-Meier procedure. Note that although SPSS does better

charts, SPSS 12 does not give confidence intervals!
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5 . 4 C H O I C E  O F  M E T H O D

Every time a study animal, dead or alive, is found, the survivorship estimate will

change. For day-to-day use, the Mayfield method is very easy to use and

understand, the estimate can be easily recalculated (as in Appendix 1), and the

method usually gives a reasonable picture of the survivorship rate. However, it

is preferable that the more complicated calculations of the Kaplan-Meier

procedure are used for reports or scientific papers that include survivorship

data. Neither method is particularly accurate where there is a short total

tracking time and / or a small number of deaths recorded. For example, there is

a big difference between a survivorship rate of 3/20 = 0.15 and one of

4/20 = 0.20 caused by one more death of a study animal, especially if those data

are then used to calculate life expectancy as 6.7 years versus 5.0 years,

respectively. The number of deaths recorded is the most critical part of the

calculations and, as a rough rule, aim to have either total tracking-years of the

study being at least ten times the average life expectancy of the study animal, or

the product of the number of deaths recorded and the number of tracking years

exceeding 500 (e.g. 50 deaths in 10 tracking years’ data, ten deaths in 50 years’

tracking data or two deaths in 250 tracking years’ data). However, remember

that the fewer deaths recorded, the greater the change made by a chance event,

or non-event; examining confidence intervals for the estimates gives a basis for

evaluating the variability in the estimates due to chance.

5 . 5 H O W  T O  E S T I M A T E  S U R V I V A L  R A T E  T O  A
P A R T I C U L A R  A G E

There is often interest in calculating the survival of animals to a particular age

(for example survival of kiwi chicks to 180 days old, at which time they seem to

become reasonably safe from predation by stoats). The Kaplan-Meier procedure

gives a survival rate as long as there are members of the group at risk. However,

it can be subject to very large error when the sample size is small. For example,

the estimate for Non-treatment survival in our kiwi chick sample is 0.1505 from

52 to 172 days, when the single chick left in the study was censored. The 95%

confidence interval is (0.027, 0.370). For the Poison treatment, the survival rate

estimate at 180 days is 0.2237, with the interval (0.067, 0.436). However, the

Non-treatment estimate in particular is based on very few data.

If constant survival rate is assumed, the Mayfield method can be used to

estimate a survival rate at any point. This assumption can be checked by looking

at a Kaplan-Meier graph with the survival axis on a log scale. The SPSS option to

get the log survival curve is described above. In Excel, double click or right

click on the vertical (y) axis to bring up the Format Axis dialogue box, choose

the Scale tab, and select logarithmic scale. To assess whether the points are

reasonably consistent with a straight line, look mainly at the points that

correspond to actual event, rather than censorship.
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The constant survival estimate of survival rate to time t is:

where L is the simple estimator of life expectancy described earlier (i.e. total

time exposed T, divided by number of deaths observed d). A confidence interval

can be calculated for this also, and the results of doing this for the kiwi chick

data are shown in Appendix 4 with estimates at 180 days. The data in Appendix

4 are derived from Appendix 2 using a simple pivot table. Note that the

estimates are similar to, but not the same as, the Kaplan-Meier estimates, as a

different model is being used. In particular, it appears to give a more realistic

estimate of survival to 180 days for Non-treatment. It is important to note that

the validity of this confidence interval is heavily dependent on the assumption

of constant survival.

The sheet used to create Appendix 4 can be modified for other data by entering

the appropriate values where there are numbers in bold: the total time exposed,

the number of deaths, and the point at which the estimate is desired. The

formula used here for the confidence interval is:

following the same notation as given above, in section 5.2 (Lawless 1982). In

Excel, the point estimate is given by the formula =EXP(-t/L), and the 95%

confidence intervals are given by =EXP(-t/(2*T)*CHIINV(0.025,2*d)) and

=EXP(-t/(2*T)*CHIINV(0.975,2*d)). When typing these formulae into Excel,

the appropriate cell references must be placed where the references L, d, t and

T are given above.

6. Comparison between two or
more groups

As an extension of the Kaplan-Meier procedure, it is possible to compare the

survivorship of animals in two or more different groups, e.g. males versus

females, or animals living under a number of different management regimes.

The most appropriate statistic to use is the nonparametric Mantel-Haenszel

statistic, which is a log-rank test whose distribution approximates a χ2

distribution with 1 degree of freedom for two groups, or (G – 1) degrees of

freedom if there are G groups. The statistic is computed by combining the two

(or more) samples to be compared. It is then determined whether the times

when deaths were recorded in the two groups are sufficiently different from

one another (given the number of animals at risk in each group at each age that

an animal died).
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To carry out this test in SPSS, continue the previous SPSS analysis by simply

clicking on the Compare Factor button on the Kaplan-Meier dialogue box, and

select Log rank > Continue to exit that box, and OK to run the survival

analysis again.

SPSS has a habit of hiding some of the text output at the bottom of the output. If

this happens, try selecting and resizing the box with the output text in it, or run

the analysis again with the other output options turned off, so that only the

results of the log-rank test are provided. In our previous example, this will give

the following SPSS output:

Given that a probability, P, of 0.0034 is well below the accepted statistical

threshold of 0.05, we conclude that kiwi chicks in the areas treated with

brodifacoum poison survived significantly better than in unpoisoned blocks

nearby. This was probably because stoats (Mustela erminea) and cats (Felis

catus), the main predators of young kiwi, were killed by secondary poisoning

after eating dead or dying rats or possums, and this clearly outweighed any risk

from accidental poisoning of the kiwi chicks themselves.

The steps in using Excel to compare two or more groups are described below

and refer to the spreadsheet in Appendix 5. The data presented is the same

chick survival data used earlier (Appendix 2).

We start by using the same pivot table as for the Kaplan-Meier procedure. Either

follow the instructions above to create an identical pivot table or copy the pivot

table shown in Table A3.1 to a new sheet and remove all the workings. (It

would be possible to add this material to the KM table, but it could become

difficult to follow.)

Test Statistics for Equality of Survival Distributions for TREAT 

 

               Statistic        df       Significance 

 

 Log Rank           8.60        1           .0034 
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Column I: n1j. The number at risk in the first group (Non-treatment) at that

time (it includes the animal that died and any animals censored at

exactly that time). This is calculated from the total in the group, less

earlier deaths and censorship. The Excel formula in the first cell in

the example is =D$47-SUM(D$5:D5), and should be copied down.

The formulae for the first cell for columns J–Q is given below in

italics, and should be copied down the sheet.

Column J: n2j. The number of animals at risk in the second group (=G$47-

SUM(G$5)).

Column K: nj. The combined total number of chicks at risk (=I6+J6).

Column L: dj. The total number of deaths at that particular tracking time (the

sum of d1j, the number of deaths in group 1 from the pivot table

column C, and d2j, the number of deaths in group 2 from the pivot

table column F (=C6+F6).

Column M: e1j. The expected number of deaths in groups 1 at that particular

time if survival was the same in the two groups (=L6*I6/K6).

Column N: e2j. The expected number of deaths in group 2 (=L6*J6/K6).

Column O: d1j – e1j. The difference between observed deaths and expected

deaths in group 1 (=C6-M6).

Column P: d2j – e2j. The difference between observed deaths and expected

deaths in group 2 (=F6-N6).

Column Q: The estimated variance of the differences (=I6*(K6-I6)*

(K6–L6)*L6/(K6*K6*(K6–1))).

(Note that columns N and P are unnecessary for this two-sample test because

they are the complement of columns M and O. They are shown here because

they would be needed if the number of groups was greater than 2.)

Next, sum the differences and square this sum to get the test statistic: add up

values in column O or column P (= ± 6.83 in the kiwi example), square the

answer (= 46.64) and divide it by the sum of variances (add up values in column

O (= 5.421)); this gives a test statistic of 8.60. This figure can then be compared

with the percentile values in statistical tables of the χ2 distribution with 1

degree of freedom. Excel calculates these for us, using the function CHIDIST(),

with the test statistic as the first argument and the degrees of freedom as the

second argument. From this kiwi example, we concluded that chick survival

was significantly better in the poisoned areas than in nearby unpoisoned areas

(P = 0.0034), as previously reported by Robertson et al. (1999).
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7. Further topics in survival data
analysis

This guide provides some simple robust tools for analysing survival data. The

Kaplan-Meier survival rate and log-rank test described herein do not include

specific assumptions about the distribution of survival times. In addition to

these tools, there are other very well-developed tools available for survival data

analysis, which can extract further information from various sorts of data. One

approach involves making specific assumptions about the way survival times

are distributed—leading to parametric models, such as the exponential model

used above, and the more flexible Weibull model. Another very important

direction involves using the Cox proportional hazard model, which allows the

inclusion of various covariates in a semi-parametric model. As more survival

studies are designed, implemented and their results analysed, some of these

more advanced approaches may be needed, but the tools covered in this guide

should provide a good starting point.

8. Availability of Excel files

Copies of the Excel files used in Appendices 1–5 are available by request from

the senior author. The files can be saved and new data substituted for the old in

the files—taking great care not to write over formulae—and after some

adjustments to data references the calculations will be done automatically.

Alternatively, the data could be copied into Excel from an electronic (pdf)

version of this manuscript. Use the text import wizard (Data > Text to

columns... using Space as the delimiter) to recreate the data tables in Excel and

follow the instructions given. Similarly, the more complex formulae could be

clipped from the pdf into Excel.



31DOC Technical Series 31

9. Discussion

Radio-tracking has become a very powerful tool for determining the

survivorship of wild animals. It is free from many of the assumptions inherent in

other methods of calculating survival using capture-recapture techniques.

Researchers must, however, be ever vigilant, because catching wild animals,

attaching transmitters to them and regularly radio-tracking them (with its

various levels of disturbance) may affect the survival chances of the study

animal. It is important to keep up with improvements in transmitter

technology, packaging and attachment methods, and to use mortality

transmitters wherever possible. If the chances of mortality are increased

through an animal wearing a transmitter, survival estimates will be

conservative, whereas with other methods biases can lead to either

conservative or inflated survival estimates.

The main problem with radio-tracking studies is obtaining a sufficiently large

sample of animals and—most importantly for long-lived species—getting a

sufficient number of recorded deaths to make the estimates reliable. The

methods described above require considerable time in the field to obtain good

survivorship estimates; however, the aim of most radio-telemetry studies is for

more than just collection of survivorship information, to ‘kill two (or more)

birds with one stone’!

The tests described here can also be used in some other situations where

animals are marked in other ways and then recaptured / resighted later.

However, be aware that with some methods the assumptions can be seriously

violated, e.g. birds often avoid recapture in mist-nets, and this can create

serious problems with capture-recapture analysis. It will often be best to use

specialist software, which is now available for this sort of data. The statistical

methods presented here also seem to be appropriate for studies of plant

survival, permitting, for instance, comparison of the survival of tagged or

counted plants in one plot or quadrat with another (e.g. grazed versus

ungrazed) at various (regular or irregular) intervals.
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Appendix 1

S U R V I V O R S H I P  D A T A  F O R  A D U L T  F E M A L E
B R O W N  K I W I

Survivorship data and calculations of simple survivorship measures from radio-

tagged adult female brown kiwi in central Northland, New Zealand (see

Robertson et al. (1999) for details of the study).

The dataset includes each individual’s band number (Band), band colour

combination (Comb) and sex (M: male; F: female); the study area in which the

individual was located (Area: P = Purua; Rp = Riponui; H = Hodge’s;

Rr = Rarewarewa); the most recent transmitter frequency used for the animal

(Tx); the date on which the continuous record of radio-tracking started (On)

and finished (Off_last), and the total tracking period (Total); and the fate of the

bird (Death: 0 = alive; 1 = dead) and cause of death (Cause), if applicable.

Ongoing records are presented in bold and records ending with death of the

individual are in italics; all other records ended due to transmitter removal or

failure, and are presented in normal font. For further information about this

data, see section 4.

Continued on next page

Band Comb Sex Area Tx On Off_last Total Death Cause

1079 B F P 37 29-Jun-94 10-Mar-95 254 0

1086 BY F P 9 22-Aug-94 12-Apr-95 233 0

1078 R F P 52 22-Aug-94 27-Oct-94 66 0

1087 YW F P 5 22-Aug-94 1-Dec-94 101 0

1088 YG F P 36 24-Aug-94 19-Oct-94 56 0

46324 RG F P 39 10-Mar-95 30-May-95 81 0

1094 RY F P 55 12-Mar-95 11-May-95 60 0

1005 GO F P 5 21-Nov-95 19-Sep-96 303 0

1078 R F P 48 12-Dec-97 21-Sep-98 283 0

1071 RW F Rp 50 8-Jun-94 7-Jul-94 29 0

1082 BW F Rp 50 20-Jul-94 15-Dec-94 148 0

1083 W F Rp 67 26-Jul-94 13-Sep-94 49 0

1071 RW F Rp 36 20-Oct-95 15-Jan-96 87 0

1069 B F Rp 82 17-Sep-96 27-Nov-96 71 0

951 YB F Rp 71 22-Jul-97 25-Sep-98 430 0

953 YBY F Rp 10 24-Dec-97 25-Sep-98 275 0

1083 W F Rp 65 18-Oct-97 22-Oct-97 4 0

1001 WO F H 25 26-May-95 31-May-95 5 0

1004 BO F H 50 20-Sep-95 20-Dec-95 91 0

1012 O F H 16 17-May-96 18-Jun-96 32 0

44912 B F H 82 25-Jun-96 27-Feb-97 247 0

1015 BR F H 17 22-Aug-96 23-Dec-96 123 0

44917 G F H 72 18-Apr-97 13-Mar-98 329 0

1012 O F H 28 26-Apr-97 6-Oct-97 163 0

1004 BO F H 69 16-Jul-97 6-Oct-97 82 1 Unknown

1092 RW F H 25 24-Sep-97 12-Mar-98 169 0
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Continued on next page

Band Comb Sex Area Tx On Off_last Total Death Cause

Appendix 1—continued

1092 RW F H 30 28-Apr-97 11-Jun-97 44 0

1012 O F H 14 17-Nov-97 17-Jun-98 212 0

35022 Y F Rr 20 2-Jan-94 19-May-94 137 0

35023 G F Rr 26 3-Jan-94 3-Jun-94 151 0

35025 O F Rr 18 3-Jan-94 24-May-94 141 0

35022 Y F Rr 37 19-May-94 27-Jun-94 39 0

44966 WG F Rr 77 20-May-94 25-Jun-94 36 0

1064 BR F Rr 34 24-May-94 23-Jun-94 30 0

35025 O F Rr 52 15-Jun-94 3-Aug-94 49 0

1072 G F Rr 21 21-Jun-94 22-Jun-94 1 0

1073 OB F Rr 58 21-Jun-94 8-Oct-94 109 0

47365 G F Rr 31 22-Jun-94 24-Sep-98 1555 0

1075 WR F Rr 17 23-Jun-94 26-Jun-94 3 0

1076 WY F Rr 61 25-Jun-94 24-Aug-94 60 0

1077 BW F Rr 77 26-Jun-94 25-Jul-94 29 0

1084 GR F Rr 77 27-Jul-94 21-Dec-94 147 0

1076 WY F Rr 34 28-Sep-94 19-Apr-95 203 0

47368 RY F Rr 52 31-Oct-94 25-Nov-94 25 0

1072 GO F Rr 62 11-Mar-95 3-Jul-98 1210 0

1065 R F Rr 16 6-Mar-95 24-Aug-98 1267 1 Dog

1062 RW F Rr 49 3-Mar-95 14-Sep-98 1291 0

1073 RG F Rr 12 1-Mar-95 28-Jul-95 149 0

1064 BR F Rr 16 11-Mar-95 10-Sep-98 1279 0

949 YR F Rr 63 1-Mar-95 11-Sep-98 1290 0

1075 WR F Rr 66 11-Mar-95 24-Sep-98 1293 0

35025 O F Rr 80 16-Mar-95 12-Dec-96 637 0

46329 YW F Rr 34 27-Apr-95 31-Aug-98 1222 0

1061 BY F Rr 71 28-Apr-95 7-Sep-98 1228 0

1095 RB F Rr 13 29-Apr-95 14-Sep-98 1234 0

44901 GY F Rr 28 23-Nov-95 8-May-96 167 0

1099 OBO F Rr 77 13-May-96 7-Jun-96 25 0

1084 GR F Rr 72 5-Aug-96 24-Sep-98 780 0

931 YGY F Rr 41 16-Aug-96 1-May-98 623 0

35025 O F Rr 52 20-May-97 24-Sep-98 492 0

44970 O M P 69 25-May-94 8-Sep-95 471 0

44971 Y M P 55 25-May-94 21-Sep-98 1580 0

44972 G M P 31 25-May-94 21-Sep-98 1580 0

35027 R M P 32 28-Jun-94 21-Sep-98 1546 0

44905 RW M P 34 22-Aug-94 21-Jun-96 669 0

47377 OG M P 32 24-Sep-94 7-Apr-95 195 0

44911 WG M P 58 24-Sep-94 23-Sep-98 1460 0

35029 YG M P 54 19-Oct-94 21-Sep-98 1433 0

1091 YW M P 66 1-Dec-94 7-May-96 523 1 Ferret

46322 B M P 47 10-Mar-95 21-Sep-98 1291 0

46323 W M P 36 10-Mar-95 17-Oct-95 221 0

46325 BW M P 46 10-Mar-95 23-Sep-98 1293 0

44927 BO M P 62 12-Mar-95 18-Sep-98 1286 0

46327 BY M P 30 12-Apr-95 21-Sep-98 1258 0

44941 RY M P 55 11-May-95 19-Apr-96 344 0

44947 GR M P 9 23-Jan-96 23-Sep-98 974 0

47468 GO M P 19 19-Sep-96 21-Sep-98 732 0
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Appendix 1—continued

Band Comb Sex Area Tx On Off_last Total Death Cause

Continued on next page

47481 S/S M P 81 18-May-98 23-Sep-98 128 0

45925 S/S M P 34 18-May-98 17-Sep-98 122 0

1067 YO M Rp 26 26-May-94 25-Sep-98 1583 0

44974 G M Rp 67 26-May-94 25-Sep-98 1583 0

44975 R M Rp 54 26-May-94 21-Oct-94 148 0

44976 O M Rp 80 27-May-94 1-Apr-98 1405 0

44977 B M Rp 32 27-May-94 10-May-95 348 1 Unknown

44978 RW M Rp 77 27-May-94 25-Sep-98 1582 0

44907 BW M Rp 40 23-Aug-94 25-Sep-98 1494 0

44904 WO M Rp 74 19-Aug-94 28-Sep-98 1501 0

44908 W M Rp 86 13-Sep-94 28-Sep-98 1476 0

44903 YB M Rp 36 18-Aug-94 25-Sep-98 1499 0

44910 BY M Rp 54 21-Oct-94 9-Dec-94 49 1 Unknown

34167 RB M Rp 60 16-Oct-97 28-Sep-98 347 0

44914 Y M H 3 25-Sep-94 29-Sep-98 1465 0

44921 BW M H 17 26-Sep-94 1-Sep-98 1436 0

44920 RW M H 32 23-Jan-95 27-Sep-96 613 1 Ferret

47451 YB M H 65 25-May-95 29-Sep-98 1223 0

47452 RG M H 12 26-May-95 8-Aug-95 74 0

44953 YO M H 31 27-May-95 15-Oct-96 507 1 Ferret

44916 G M H 47 27-May-95 8-Aug-96 439 1 Ferret

47454 RY M H 49 27-May-95 13-Aug-95 78 0

47457 YG M H 27 29-May-95 7-Aug-95 70 0

47458 GR M H 64 30-May-95 29-Sep-98 1218 0

47459 BO M H 18 31-May-95 7-Sep-95 99 0

44918 R M H 44 31-May-95 1-Sep-98 1189 1 Possum

47459 BO M H 62 20-Dec-95 8-Jan-98 750 0

47463 O M H 70 18-Jun-96 29-Sep-98 833 0

47457 YG M H 37 22-Aug-96 29-Sep-98 768 0

43485 ROYG M H 47 4-Dec-96 29-Sep-98 664 0

47459 BO M H 79 20-May-98 29-Sep-98 132 0

47454 RY M H 14 17-Jun-98 29-Sep-98 104 0

35024 O M Rr 1 3-Jan-94 3-Jan-94 0 0

44962 W M Rr 33 19-May-94 24-Sep-98 1589 0

44963 B M Rr 30 19-May-94 24-Sep-98 1589 0

44964 RW M Rr 57 20-May-94 24-Sep-98 1588 0

44965 BY M Rr 46 20-May-94 27-Jun-94 38 0

44967 O M Rr 50 24-May-94 24-Sep-98 1584 0

44968 R M Rr 29 24-May-94 7-Sep-98 1567 0

44979 WO M Rr 67 21-Jun-94 29-Jun-94 8 0

44980 GO M Rr 79 22-Jun-94 18-Feb-96 606 0

44981 BR M Rr 85 22-Jun-94 24-Sep-98 1555 0

47366 G M Rr 7 22-Jun-94 6-Dec-96 898 1 Drowned

47367 YR M Rr 85 23-Jun-94 21-Feb-96 608 1 Unknown

44983 GW M Rr 74 24-Jun-94 19-Aug-96 787 1 Dog / Ferret

47369 RY M Rr 77 24-Jun-94 28-Sep-98 1557 0

44984 RO M Rr 78 25-Jun-94 24-Sep-98 1552 0

44987 YO M Rr 39 25-Jun-94 11-Sep-98 1539 0

47370 WY M Rr 34 26-Jun-94 16-Aug-94 51 0

44988 WR M Rr 15 26-Jun-94 11-Feb-98 1326 0

44989 GB M Rr 27 26-Jun-94 24-Sep-98 1551 0
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44990 BW M Rr 59 6-Jul-94 24-Sep-98 1541 0

44909 OB M Rr 58 8-Oct-94 29-Aug-95 325 0

47370 G M Rr 53 19-Apr-95 24-Sep-98 1254 0

46328 YW M Rr 70 27-Apr-95 22-Jan-96 270 1 Unknown

47373 YG M Rr 21 29-Apr-95 7-Sep-98 1227 0

44928 RB M Rr 11 29-Apr-95 14-Sep-98 1234 0

44929 OR M Rr 23 4-May-95 30-Aug-95 118 0

46330 OG M Rr 18 5-May-95 24-Sep-98 1238 0

47460 RG M Rr 5 11-Jul-95 24-Sep-98 1171 0

47462 GY M Rr 15 8-May-96 24-Sep-98 869 0

47465 GWB M Rr 73 16-May-96 11-Sep-98 848 0

44980 YB M Rr 75 25-Jun-96 24-Sep-98 821 0

47474 YW M Rr 24 21-Mar-97 24-Sep-98 552 0

34169 S/S M Rr 65 23-Oct-97 3-Mar-98 131 0

44988 WR M Rr 35 11-May-98 24-Sep-98 136 0

47487 YGY M Rr 83 16-Jun-98 28-Sep-98 104 0

47488 S/S M Rr 25 3-Sep-98 10-Sep-98 7 0

Total: 94551 days

258.87 years

13 deaths

Estimates based on the assumption of constant survival:

survival rate 0.9498 (= 1 – (deaths/years))

 mortality rate 0.0502

life expectancy 19.9128 years/deaths

Appendix 1—continued

Band Comb Sex Area Tx On Off_last Total Death Cause
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Band Tx Area Treatmen On Off_last Cdays Death?

FRI5304 97 P Non-treatment 22-Feb-97 25-Feb-97 3 1

393F 25 P Non-treatment 10-Oct-97 14-Oct-97 4 1

FRI1989 76 Rp Poison 15-Oct-97 19-Oct-97 4 1

C13 23 P Non-treatment 9-Feb-97 17-Feb-97 8 1

C9 12 P Non-treatment 19-Sep-96 27-Sep-96 8 1

C10 12 P Non-treatment 9-Oct-96 19-Oct-96 10 1

C11 25 P Non-treatment 11-Oct-96 21-Oct-96 10 0

399F 91 Rr Poison 17-Oct-97 29-Oct-97 12 1

387F 27 P Non-treatment 26-Sep-97 10-Oct-97 14 1

C11 27 Rr Poison 18-Oct-96 1-Nov-96 14 1

386F 37 P Non-treatment 12-Sep-97 27-Sep-97 15 1

B0884 74 Rr Poison 13-Jan-98 28-Jan-98 15 1

363F 96 Rr Poison 21-Oct-96 6-Nov-96 16 1

C12 29 P Non-treatment 11-Oct-96 27-Oct-96 16 1

C8 40 Rp Poison 24-Dec-97 9-Jan-98 16 0

366F 45 Rr Poison 18-Oct-96 4-Nov-96 17 0

387F 91 Rr Poison 22-Sep-97 9-Oct-97 17 1

C14 37 Rr Poison 22-Oct-96 9-Nov-96 18 1

FRI1988 74 Rp Poison 14-Oct-97 1-Nov-97 18 1

C7 33 Rp Poison 19-Dec-97 9-Jan-98 21 0

FRI5303 94 P Non-treatment 14-Feb-97 7-Mar-97 21 1

Huia 95 Rr Poison 7-Jan-97 28-Jan-97 21 0

396F 35 Rr Poison 17-Sep-97 9-Oct-97 22 1

c15 96 Rr Poison 5-Sep-97 27-Sep-97 22 0

B-0894 29 Rp Poison 31-Mar-98 23-Apr-98 23 1

C18 91 Rr Poison 16-Feb-98 14-Mar-98 26 0

395f 29 P Non-treatment 26-Sep-97 27-Oct-97 31 1

FRI1990 79 Rp Poison 3-Oct-97 3-Nov-97 31 1

Appendix 2

S U R V I V O R S H I P  D A T A  F O R  B R O W N  K I W I

C H I C K S

Survivorship data for brown kiwi chicks exposed to brodifacoum poison

(Poison) and in nearby untreated forest patches (Non-treatment) in 1996–98

(see Robertson et al. (1999) for more details). The data have been sorted by

tracking interval.

The dataset includes each individual’s band number (Band) and transmitter

frequency (Tx); the study area in which it was located (Area) and the

management regime for that area (Treatmen: Poison = treated with

brodifacoum poison; Non-treatment = untreated); the date on which the

continuous record of radio-tracking started (On) and finished (Off_last), and the

total tracking period (Cdays); and the fate of the bird (Death?: 0 = alive; 1 =

dead). Records ending with death of the individual are presented in italics. For

further information about this data, see section 5.3.

Continued on next page
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Band Tx Area Treatmen On Off_last Cdays Death?

C17 90 Rr Poison 15-Oct-97 16-Nov-97 32 0

372F 31 P Non-treatment 14-Oct-96 17-Nov-96 34 1

400F 95 Rr Poison 17-Oct-97 20-Nov-97 34 0

B0879 94 Rr Poison 23-Dec-97 27-Jan-98 35 1

B0876 91 P Non-treatment 18-Nov-97 25-Dec-97 37 1

B0885 36 P Non-treatment 28-Jan-98 7-Mar-98 38 0

C8 36 P Non-treatment 19-Sep-96 28-Oct-96 39 1

C13 27 Rr Poison 21-Oct-96 7-Dec-96 47 0

398F 94 Rr Poison 24-Sep-97 14-Nov-97 51 1

394F 40 P Non-treatment 26-Sep-97 17-Nov-97 52 1

C9 40 Rp Poison 3-Feb-98 28-Mar-98 53 1

397F 45 P Non-treatment 26-Sep-97 30-Nov-97 65 0

B0880 25 Rr Poison 23-Dec-97 1-Mar-98 68 0

FRI5307 31 Rr Poison 24-Sep-97 3-Dec-97 70 0

367F 88 Rr Poison 24-Oct-96 4-Jan-97 72 0

382F 27 Rr Poison 6-Jan-97 20-Mar-97 73 0

376F 17 Rr Poison 18-Oct-96 2-Jan-97 76 0

392F 97 Rr Poison 17-Oct-97 5-Jan-98 80 1

47476 * 90 Rr Poison 18-Sep-96 23-Dec-96 96 0

B0877 90 Rr Poison 5-Dec-97 21-Mar-98 106 1

377F 96 Rr Poison 14-Nov-96 6-Mar-97 112 1

384F 94 Rr Poison 17-Mar-97 14-Jul-97 119 1

FRI5306 17 Rr Poison 17-Sep-97 23-Jan-98 128 1

388F 35 Rr Poison 17-Sep-97 25-Feb-98 161 0

385F 35 H Non-treatment 2-May-97 21-Oct-97 172 0

371F 91 Rr Poison 21-Oct-96 14-Apr-97 175 1

FRI5308 88 Rr Poison 17-Oct-97 17-May-98 180 0

47478 29 Rr Poison 13-Nov-96 1-Oct-97 180 0

47477 12 Rr Poison 12-Sep-96 3-Sep-97 180 0

Appendix 2—continued

* A second record of chick 47476 was not included as it was already over 180 days old when recaptured.
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Appendix 3

C A L C U L A T I O N  O F  K A P L A N - M E I E R  E S T I M A T E S
A N D  9 5 %  C O N F I D E N C E  I N T E R V A L S

Excel spreadsheets used for deriving Kaplan-Meier estimates (Table A3.1) and

95% confidence intervals (Table A3.2) for the survival of brown kiwi chicks in

treated (poison) and non-treated (Non-treat) areas. The raw data are given in

Appendix 2. Calculations are outlined in section 5.3.2.
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Appendix 4

C A L C U L A T I O N  O F  S U R V I V A L  T O  A  G I V E N
N U M B E R  O F  D A Y S

Excel spreadsheet for the calculation of survival of brown kiwi to a given

number of days based on the assumption of constant survival rate, using data

from Appendix 2. Calculations are outlined in section 5.5.
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Appendix 5

C A L C U L A T I O N  O F  T H E  M A N T E L - H A E N S Z E L
S T A T I S T I C

Excel spreadsheet used to calculate the Mantel-Haenszel statistic comparing the

survival rate in two populations of brown kiwi chicks, one in an area where

possums (and probably other predators) were being poisoned, and a second in a

nearby non-treatment area. The raw data are given in Appendix 2. Calculations

are outlined in section 6.
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